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Chapter 1

cosFileTransfer User’s Guide

The cosFileTransfer Application is an Erlang implementation of the OMG CORBA FileTransfer Service.

1.1 The cosFileTransfer Application

1.1.1 Content Overview

The cosFileTransfer documentation is divided into three sections:

� PART ONE - The User’s Guide
Description of the cosFileTransfer Application including services and a small tutorial
demonstrating the development of a simple service.

� PART TWO - Release Notes
A concise history of cosFileTransfer.

� PART THREE - The Reference Manual
A quick reference guide, including a brief description, to all the functions available in
cosFileTransfer.

1.1.2 Brief description of the User’s Guide

The User’s Guide contains the following parts:

� cosFileTransfer overview

� cosFileTransfer installation

� A tutorial example

1.2 Introduction to cosFileTransfer

1.2.1 Overview

The cosFileTransfer application is a FileTransfer Service compliant with the OMG1 Service
CosFileTransfer.

1URL: http://www.omg.org
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Chapter 1: cosFileTransfer User’s Guide

Purpose and Dependencies

If a Virtual File System is started as ’FTP’, the intes-2.5.4 application, or later, must be installed.

cosFileTransfer is dependent on Orber, which provides CORBA functionality in an Erlang environment,
and cosProperty.

Prerequisites

To fully understand the concepts presented in the documentation, it is recommended that the user is
familiar with distributed programming, CORBA, the Orber and cosProperty applications.

Recommended reading includes CORBA, Fundamentals and Programming - Jon Siegel and Open Telecom
Platform Documentation Set. It is also helpful to have read Concurrent Programming in Erlang.

1.3 Installing cosFileTransfer

1.3.1 Installation Process

This chapter describes how to install cosFileTransferApp [page 17] in an Erlang Environment.

Preparation

Before starting the installation process for cosFileTransfer, the application Orber must be running and
cosProperty installed by using cosProperty:install(). Please note that it is NOT necessary to use
cosProperty:install db() for running the cosFileTransfer application.

Configuration

When starting the cosFileTransfer application the following configuration parameters can be used:

� buffert size - default is 64000. This option determine how many bytes will be read at a time when
transfering files.

1.4 Using the File Transfer Service

1.4.1 Overview

This chapter describes how two File Transfer Service applications interact.

2 cosFileTransfer Application



1.4: Using the File Transfer Service

Components

There are several ways the OMG File Transfer Service can be used. Below one scenario is visualized:

Figure 1.1: Figure 1: The File Transfer Service Components.

� Source ORB: this is the ORB we want to transfer a file from/via and it holds an object reference to
a Virtual File System (VFS) [page 16] which, in this example, represents an FTP server.

� Target ORB: the goal may be, for example, to transfer a new file or append to an existing file
placed at the location that this ORB’s VFS represents. In this scenario it is the local disk or the
NFS.

� Transport Protocol: initially the ORB’s, i.e., target and source, communicate via normal CORBA
requests to determine whether or not they can communicate. If the File Transfer Service’s have
one, or more, Transport Protocol in common the data will be streamed using this protocol. The
cosFileTransfer application currently supports TCP/IP and SSL.

Which type of file system the VFS is supposed to represent is determined by the options given when
creating it, which is also how one determine which Transport Protocol to use. Hence, the source and
target VFS described above can be started by invoking, respectively, the following operations:

3cosFileTransfer Application



Chapter 1: cosFileTransfer User’s Guide

1> SVFS = cosFileTransferApp:create_VFS(’FTP’, [], Host, 21, [{protocol, tcp}]),
2> TVFS = cosFileTransferApp:create_VFS({’NATIVE’, ’cosFileTransferNATIVE_file’},

[], OtherHost, 0, [{protocol, tcp}]),

Naturally can any combination of VFS-types be used and it is also possible to use own drivers, i.e.,
f’NATIVE’, ’MyDriver’g.

After creating necessary VFS’s we can login in and perform operations on files and directories residing
on each file system.

How To Use SSL

To be able to use SSL as transport protocol a few configuration parameters must be set. The required
parameters depend on if Orber is the target or/and the source ORB. However, the SSL CERT FILE
variable must be defined in both cases.

Setting of a CA certificate file with an option does not work due to weaknesses in the SSLeay package.
A work-around in the ssl application is to set the OS environment variable SSL CERT FILE before SSL
is started. However, then the CA certificate file will be global for all connections (both incomming and
outgoing calls).

Configurations when cosFileTransfer is Used as Target The following three configuration
variables can be used to configure cosFileTransfer’s SSL target behavior.

� ssl server certfile which is a path to a file containing a chain of PEM encoded certificates for
cosFileTransfer as target.

� ssl server verify which specifies type of verification: 0 = do not verify peer; 1 = verify peer, verify
client once, 2 = verify peer, verify client once, fail if no peer certificate. The default value is 0.

� ssl server depth which specifies verification depth, i.e. how far in a chain of certificates the
verification process shall proceed before the verification is considered successful. The default
value is 1.

There also exist a number of API functions for accessing the values of these variables:

� cosFileTransferApp:ssl server certfile/0

� cosFileTransferApp:ssl server verify/0

� cosFileTransferApp:ssl server depth/0

Configurations when cosFileTransfer is used as Source Below is the list of configuration variables
used when cosFileTransfer act as the source application.

� ssl client certfile which is a path to a file containing a chain of PEM encoded certificates used in
outgoing calls.

� ssl client verify which specifies type of verification: 0 = do not verify peer; 1 = verify peer, verify
client once, 2 = verify peer, verify client once, fail if no peer certificate. The default value is 0.

� ssl client depth which specifies verification depth, i.e. how far in a chain of certificates the
verification process shall proceed before the verification is considered successful. The default
value is 1.

There also exist a number of API functions for accessing the values of these variables in the client
processes:
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� cosFileTransferApp:ssl client certfile/0

� cosFileTransferApp:ssl client verify/0

� cosFileTransferApp:ssl client depth/0

1.5 cosFileTransfer Examples

1.5.1 A tutorial on how to create a simple service

Initiate the application

To use the complete cosFileTransfer application cosProperty must be installed.

How to run everything

Below is a short transcript on how to run cosFileTransfer.

%% Start Mnesia and Orber
mnesia:delete_schema([node()]),
mnesia:create_schema([node()]),
orber:install([node()]),
mnesia:start(),
orber:start(),

%% The File Transfer Service depends on the cosProperty
%% application. Hence, we must install cosProperty first.
%% It’s NOT necessary to invoke cosProperty:install_db().
cosProperty:install(),

%% Install File Transfer Service in the IFR.
cosFileTransfer:install(),

%% Now start the application and necessary services.
cosFileTransfer:start(),

%% Create two Virtual File Systems respectively representing an FTP-
%% and the local NFS file system.
VFSFTP = cosFileTransferApp:create_VFS(’FTP’, [], FTPHost, 21),
VFSNATIVE = cosFileTransferApp:

create_VFS({’NATIVE’, ’cosFileTransferNATIVE_file’},
[], MyLocalHost, 0),

%% Login to each system.
{FSFTP, DirFTP} = ’CosFileTransfer_VirtualFileSystem’:

login(VFSFTP, "myId", "myPwd", "myAccount"),
{FSNATIVE, DirNATIVE} = ’CosFileTransfer_VirtualFileSystem’:

login(VFSNATIVE, "myId", "myPwd", "myAccount"),

%% If we want to copy a file from the NFS to the FTP we must first
%% create a File object which contains its attributes.
Target = ’CosFileTransfer_FileTransferSession’:create_file(FSFTP,

5cosFileTransfer Application



Chapter 1: cosFileTransfer User’s Guide

["/", "ftp", "incoming", "targetFile"])),

#’CosFileTransfer_FileWrapper’{the_file = Dir} =
%% Lookup the file we want to copy.
FileWrapper = ’CosFileTransfer_FileTransferSession’:get_file(FSNATIVE,

["/", "home", "myId", "sourceFile"]),
Source = FileWrapper#’CosFileTransfer_FileWrapper’.the_file,

%% Now we are ready to transfer the file. Please note that we most
%% call the source Session object.
’CosFileTransfer_FileTransferSession’:transfer(FSNATIVE, Source, Target),
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Short Summaries

� Erlang Module CosFileTransfer Directory [page 10] – This module implements
the OMG CosFileTransfer::Directory interface.

� Erlang Module CosFileTransfer File [page 11] – This module implements the
OMG CosFileTransfer::File interface.

� Erlang Module CosFileTransfer FileIterator [page 12] – This module implements
the OMG CosFileTransfer::FileIterator interface.

� Erlang Module CosFileTransfer FileTransferSession [page 13] – This module
implements the OMG CosFileTransfer::FileTransferSession interface.

� Erlang Module CosFileTransfer VirtualFileSystem [page 16] – This module
implements the OMG CosFileTransfer::VirtualFileSystem interface.

� Erlang Module cosFileTransferApp [page 17] – The main module of the
cosFileTransfer application.

CosFileTransfer Directory

The following functions are exported:

� list(Directory, Max) -> Return
[page 10] Return a list, of length Max or less, containing Object References
representing files or directories contained within the target Directory and a
FileIterator or a NIL object

CosFileTransfer File

The following functions are exported:

� ’ get name’(File) -> string()
[page 11] Return the target object’s associated name

� ’ get complete file name’(File) -> string()
[page 11] Return the target object’s associated absolute name.

� ’ get parent’(File) -> Directory
[page 11] Return the target object’s container.

� ’ get associated session’(File) -> FileTransferSession
[page 11] Return the target object’s associated FileTransferSession
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CosFileTransfer FileIterator

The following functions are exported:

� next one(Iterator) -> Return
[page 12] Return the next FileWrapper and a boolean which indicate whether the
FileWrapper is valid or not.

� next n(Iterator, Max) -> Return
[page 12] Return a list, of length Max or less, containing FileWrappers and a
boolean which indicates if more FileWrappers exists

� destroy(Iterator) -> ok
[page 12] Terminate the target object

CosFileTransfer FileTransferSession

The following functions are exported:

� ’ get protocols supported’(FTS) -> Return
[page 13] Return the protocols supported by the target object

� set directory(FTS, Directory) -> Return
[page 13] Change the current working directory of the target object’s associated
file system

� create file(FTS, FileNameList) -> Return
[page 13] Create a File Object representing a file which may or may not exist

� create directory(FTS, FileNameList) -> Return
[page 13] Create a new directory in the target objects associated file systems
domain

� get file(FTS, FileNameList) -> Return
[page 14] Create a FileWrapper which represents a file or directory

� delete(FTS, File) -> Return
[page 14] Delete the file or directory, represented by the File object, from the
target objects associated file system

� transfer(FTS, SourceFile, DestinationFile) -> Return
[page 14] Copy the file represented by the SourceFile from the target object’s file
system to a file in the destination FileTransferSession’s file system

� append(FTS, SourceFile, DestinationFile) -> Return
[page 14] Append the file represented by the SourceFile from the target object’s
file system to a file in the destination FileTransferSession’s file system

� insert(FTS, SourceFile, DestinationFile, Offset) -> Return
[page 15] Insert the SourceFile into the DestinationFile Offset bytes from the
start of the file

� logout(FTS) -> ok
[page 15] Terminate the target object and close the connection to the file system it
represents
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CosFileTransfer VirtualFileSystem

The following functions are exported:

� ’ get file system type’(VFS) -> Return
[page 16] Return the target object’s associated file system

� ’ get supported content types’(VFS) -> Return
[page 16] Return the target object’s supported content types.

� login(VFS, User, Password, Account) -> Return
[page 16] Create a new instance of a FileTransferSession and a Directory

cosFileTransferApp

The following functions are exported:

� install() -> Return
[page 17] Install the cosFileTransfer application

� uninstall() -> Return
[page 17] Uninstall the cosFileTransfer application

� start() -> Return
[page 17] Start the cosFileTransfer application

� stop() -> Return
[page 17] Stop the cosFileTransfer application

� create VFS(Type, Content, Host, Port [,Options]) -> Return
[page 17] Create a new instance of a Virtual File System

� ssl server certfile() -> string()
[page 18] Display the path to the target certificate

� ssl client certfile() -> string()
[page 18] Display the path to the client certificate

� ssl server verify() -> 0 | 1 | 2
[page 18] Display the SSL verification type for incoming calls

� ssl client verify() -> 0 | 1 | 2
[page 18] Display the SSL verification type for outgoing calls

� ssl server depth() -> int()
[page 18] Display the SSL verification depth for incoming calls

� ssl client depth() -> int()
[page 18] Display the SSL verification depth for outgoing calls
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CosFileTransfer Directory
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

This module also exports the functions described in:

� CosFileTransfer File [page 11]

� CosPropertyService PropertySetDef in the cosProperty application.

Exports

list(Directory, Max) -> Return

Types:

� Directory = #objref
� Return = fok, FileList, FileIteratorg
� FileList = [File]
� File = FileIterator = #objref

This operation returns a list, of length Max or less, containing Object References
representing files or directories contained within the target Directory. If the amount of
objects found is less than Max the returned Iterator will be a NIL object.
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CosFileTransfer File
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

This module also exports the functions described in:

� CosPropertyService PropertySetDef in the cosProperty application.

Exports

’ get name’(File) -> string()

Types:

� File = #objref

This read only attribute represents the target object’s associated name.

’ get complete file name’(File) -> string()

Types:

� File = #objref

This read only attribute represents the target object’s associated absolute name.

’ get parent’(File) -> Directory

Types:

� File = Directory = #objref

This read only attribute represents the target object’s container. In some cases a NIL
object will be returned.

’ get associated session’(File) -> FileTransferSession

Types:

� File = FileTransferSession = #objref

This read only attribute represents the target object’s associated FileTransferSession.
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CosFileTransfer FileIterator
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

Exports

next one(Iterator) -> Return

Types:

� Iterator = #objref
� Return = fboolean(), #’CosFileTransfer FileWrapper’fthe file = File file type =

Typegg
� File = #objref
� Type = nfile | ndirectory

This opertion returns true if a FileWrapper exists at the current position and the out
parameter contains a valid File reference. If false is returned the out parameter is a
non-valid FileWrapper.

next n(Iterator, Max) -> Return

Types:

� Iterator = #objref
� Max = unsigned long()
� Return = fboolean(), FileListg
� FileList = [#’CosFileTransfer FileWrapper’fthe file = File file type = Typeg]
� File = #objref
� Type = nfile | ndirectory

This operation returns true if the requested number of FileWrappers can be delivered
and there are additional FileWrappers. If false is returned a list, of length Max or less,
containing the last valid FileWrappers associated with the target object.

destroy(Iterator) -> ok

Types:

� Iterator = #objref

This operation terminates the target object.
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CosFileTransfer FileTransferSession
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

Exports

’ get protocols supported’(FTS) -> Return

Types:

� FTS = #objref
� Return = [#’CosFileTransfer ProtocolSupport’fprotocol name=Type,

addresses=[Address]g]
� Type = Address = string()

This read only attribute returns the protocols supported by the target object.

set directory(FTS, Directory) -> Return

Types:

� FTS = Directory = #objref
� Return = ok | f’EXCEPTION, Eg

Invoking this operation will change the current working directory of the target object’s
associated file system. If fail to do so the appropriate exception is raised.

create file(FTS, FileNameList) -> Return

Types:

� FTS = #objref
� FileNameList = [string()]
� Return = File | f’EXCEPTION, Eg
� File = #objref

This operation creates a File Object representing a file which may or may not exist.
For this operation to be independent of the working cirectory the supplied
FileNameList must represent the absolute name.

create directory(FTS, FileNameList) -> Return

Types:

� FTS = #objref
� FileNameList = [string()]
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� Return = Directory | f’EXCEPTION, Eg
� Directory = #objref

This operation creates a new directory in the target objects associated file systems
domain. If fail to do so an exception is raised but, if successfull, a Directory object
representing the new directory is returned.

get file(FTS, FileNameList) -> Return

Types:

� FTS = #objref
� FileNameList = [string()]
� Return = FileWrapper | f’EXCEPTION, Eg
� FileWrapper = #’CosFileTransfer FileWrapper’fthe file = File file type = Typeg
� File = #objref
� Type = nfile | ndirectory

This operation, creates a FileWrapper which represents a file or directory, and should
be independent of the working Directory, i.e., a full path name must be supplied.
Furthermore, the file or directory represented by the FileNameList must exist.

delete(FTS, File) -> Return

Types:

� FTS = File = #objref
� Return = ok | f’EXCEPTION’, Eg

This operation removes the file or directory, represented by the File object, from the
target objects associated file system. If it is a non-empty directory or non-existing file or
directory an exception is raised.

transfer(FTS, SourceFile, DestinationFile) -> Return

Types:

� FTS = SourceFile = DestinationFile = #objref
� Return = ok | f’EXCEPTION’, Eg

If the target object’s and the DestinationFile’s associated FileTransferSession’s
support the same protocol(s) this operation will copy the file represented by the
SourceFile from the target object’s file system to a file in the destination
FileTransferSession’s file system. The file is represented by the DestinationFile
object and may not exist. This operation must be invoked on the
FileTransferSession associated with the SourceFile object.

append(FTS, SourceFile, DestinationFile) -> Return

Types:

� FTS = SourceFile = DestinationFile = #objref
� Return = ok | f’EXCEPTION’, Eg

This operation behaves almost like the transfer/3 operation. The difference is that the
DestinationFile must exist since the SourceFile will be appended to the
DestinationFile.

Currently, it is not possible to use this operation when the target object represents FTP.
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insert(FTS, SourceFile, DestinationFile, Offset) -> Return

Types:

� FTS = SourceFile = DestinationFile = #objref
� Offset = long()
� Return = ok | f’EXCEPTION’, Eg

This operation behaves almost like the append/3 operation. The difference is that the
SourceFile will be inserted into the DestinationFile Offset bytes from the start of
the file.

Currently, it is not possible to use this operation when the target object represents FTP.

logout(FTS) -> ok

Types:

� FTS = #objref

This opertion terminates the target object and closes the connection to the file system it
represents.
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CosFileTransfer VirtualFileSystem
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

Exports

’ get file system type’(VFS) -> Return

Types:

� VFS = #objref
� Return = ’FTP’ | ’NATIVE’

This read only attribute represents the target object’s associated file system.

’ get supported content types’(VFS) -> Return

Types:

� VFS = #objref
� Return =

This read only attribute represents the target object’s supported content types.

login(VFS, User, Password, Account) -> Return

Types:

� VFS = #objref
� User = Password = Account = string()
� Return = fFileTransferSession, Directoryg | f’EXCEPTION’, Eg
� FileTransferSession = Directory = #objref

This operation creates a new instance of a FileTransferSession and a Directory. The
later represents the current working directory of the returned FileTransferSession.
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cosFileTransferApp
Erlang Module

To get access to the record definitions for the structures use:
-include lib("cosFileTransfer/include/*.hrl").

This module contains the functions for starting and stopping the application.

Exports

install() -> Return

Types:

� Return = ok | f’EXIT’, Reasong

This operation installs the cosFileTransfer application. Note, the cosProperty
application must be installed prior to invoking this operation.

uninstall() -> Return

Types:

� Return = ok | f’EXIT’, Reasong

This operation uninstalls the cosFileTransfer application.

start() -> Return

Types:

� Return = ok | ferror, Reasong

This operation starts the cosFileTransfer application.

stop() -> Return

Types:

� Return = ok | ferror, Reasong

This operation stops the cosFileTransfer application.

create VFS(Type, Content, Host, Port [,Options]) -> Return

Types:

� Type = ’FTP’ | f’NATIVE’, ’cosFileTransferNATIVE file’g | f’NATIVE’, MyModuleg
� Content = []
� Host = string(), e.g. ”myHost@myServer” or ”012.345.678.910”
� Port = integer()
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� Options = [Option]
� Option = fprotocol, Protocolg | fconnect timeout, Secondsg
� Protocol = tcp | ssl
� Return = VFS | f’EXCEPTION, Eg
� VFS = #objref

This operation creates a new instance of a Virtual File System. The Type parameter
determines which type we want the VFS to represent. ’FTP’ maps to the INTES ftp
implementation, while f’NATIVE’, ’cosFileTransferNATIVE file’g uses the file
module. It is also possible to implement own mappings which are activated by
supplying f’NATIVE’, MyModuleg. The MyModule module must export the same
functions and behave in the same way as the INETS ftp module.

If no Options are supplied the default setting will be used, i.e., tcp and 60 seconds.

The Content parameter is currently ignored by must be supplied as an empty list.

ssl server certfile() -> string()

This function returns a path to a file containing a chain of PEM encoded certificates for
the cosFileTransfer as target. This is configured by setting the application variable
ssl server certfile.

ssl client certfile() -> string()

This function returns a path to a file containing a chain of PEM encoded certificates
used in outgoing calls. The default value is configured by setting the application variable
ssl client certfile.

ssl server verify() -> 0 | 1 | 2

This function returns the type of verification used by SSL during authentication of the
other peer for incoming calls. It is configured by setting the application variable
ssl server verify.

ssl client verify() -> 0 | 1 | 2

This function returns the type of verification used by SSL during authentication of the
other peer for outgoing calls. The default value is configured by setting the application
variable ssl client verify.

ssl server depth() -> int()

This function returns the SSL verification depth for incoming calls. It is configured by
setting the application variable ssl server depth.

ssl client depth() -> int()

This function returns the SSL verification depth for outgoing calls. The default value is
configured by setting the application variable ssl client depth.
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